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Welcome to Motion Builder

Motion Builder is a Microsoft WindowsÔ-based graphical programming tool
that allows you to easily program CompumotorÕs 6000 Series products with
visual icons.  These visual icons, representing the motion function you want
to perform, are simply dragged and dropped onto a program palette.  Using
Motion Builder with the 6000 Series products allows you to design and
program your application in a flow chart methodology.  This software tool
decreases the learning curve, shortening your system design time, and
reducing your overall system cost.

How to Give Your Feedback
We want your feedback to help guide our work on future improvements and
enhancements to Motion Builder.  If Motion Builder does not seem to work
as you expected, or if you have an idea of how to make it work better, please
let us know!  (Known problems are noted in Motion Builder's readme.txt
file.)

¥ FAX us at 707-584-2446.
¥ E-mail us at mbuilder@cmotor.com (use questionnaire as content guide).
¥ Call 800-358-0020 or 707-584-2558 and leave a voicemail message in

mailbox 2606.

System Requirements

Motion Builder requires the following:

¥ 486 @ 66 MHz or higher
¥ Windows 3.1 or Windows95
¥ 8 MB RAM

Motion Builder can be used as is, without a controller.  Of course, if you
want to download and run the code that is generated, you must have a 6000
family controller.  All the controllers in the 6000 family are supported
(ZETA6104, APEX615n Series, AT6200 & AT6400, AT6250 & AT6450,
6200, 6201, 6250 & 6270, OEM6200, OEM6250 & OEM-AT6400).
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How to Install Motion Builder

Motion Builder is equipped with an install wizard to ease installation.  There
is also an un-install feature so you can remove Motion Builder from your
system when updated versions become available.

Put disk one in your floppy drive and run the ÒsetupÓ program to begin
installation.  Follow the instructions on screen to complete the installation.

How to Get Help

Motion Builder has an integrated help system to aid in programming.  The
help system provides context-sensitive help and also functions as a
comprehensive on-line manual.  This is the predominant reference for
Motion Builder.

To get context-sensitive help about specific icons, pull-down menu items
and dialog boxes, select the icon (and hold down the mouse button), menu
item or open the dialog box and press the F1 key.

From the Help pull-down menu (see illustration below), you can access the
help system table of contents (Contents), keyword search facility (Search
for Help on...), and how-to information on specific programming tasks
(How to).

If you are not familiar with Windows help system features (e.g., placing
bookmarks, adding annotations, printing, copying/pasting, keeping help on
top of other windows), you can find instructions by selecting Using Help
from the Help menu.

If you need additional technical support:

¥ Phone us at 800-358-9070 or 707-584-7558
¥ E-mail us at tech_help@cmotor.com
¥ FAX us at 707-584-3793
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Motion Builder Icons

The icons in Motion Builder are symbolic representations of motion and
communications functions for the 6000 Series of controllers/indexers.  Select
the icons that correspond to the motion control activities you wish to
perform.  Arrange the icons on your computer screen to indicate the desired
flow of motion and I/O, essentially creating a flowchart of motion and
communication.  Set the parameters for the chosen functions using the icon
dialog boxes.

Refer to the Icon Description section of this manual for descriptions of the
icons and their associated dialog boxes.

Select and Place Icons
Position the cursor over the Icon on the Icon palette and depress the left
mouse button to select it.  The color of the button will change to indicate
that it was selected, and the cursor will change to a small square shape.
Position the cursor in the desired position, and click the left mouse button to
place the Icon.  Once selected, an icon stays selected until another icon is
selected.

Drag and Align Icons
Position the cursor over the desired icon and depress the left mouse button to
grab and drag the Icon to the desired position on the program sheet.  Position
the icons manually, or select the icons and use the alignment commands
from the toolbar or Align Menu to align the icons.

Open and Complete Icon Dialog Boxes
Position the cursor over the icon and double-click the left mouse button to
open the Icon dialog box.  Fill in the pertinent parameters.
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Linking Icons
Each icon has an input handle and an output handle*.  The Input handle is
always on the left side of the icon, and Output handle is always on the right.
Connect the output and input handles of the desired two icons using the
Linking function to direct the program flow from one icon to the next.

Motion Builder requires that links be made in the direction of program flow,
so always connect to the Output handle first.  The Link line will include an
arrow to show the direction of program flow.  Motion Builder will not accept
links from an Input handle back to an Output handle.  Motion Builder will
not allow you to connect an Input handle to another Input handle, or an
Output handle to an Output handle.

Once selected, the Link Icon function stays selected until you select another
icon, the Pointer, or by double-clicking your left mouse button.  If you start
a link and wish to delete it, double-click your left mouse button

1. Select the Link tool (  ) from the icon palette.  After selecting the
Link tool, when you pass the cursor over the program worksheet area,
the cursor becomes a cross-hair (+).

2. Click the mouse on the right side (the output side) of the icon and then
click the mouse again on the left side (the input side) of the icon you
want to link.  After you click on an icon's output, when you move the
cursor, a dashed line trails behind.  When you link successfully to the
targeted icon, the line becomes solid with an arrowhead indicating the
direction of program flow.  The diagram below illustrates the
input/output connections.

1. Click

2. Drag

            

3. Click

NOTEÑThe If Condition icon has one output for True and one for False:

*Exceptions:  Conditional IF, End Program, and Begin Program Icons.
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What are Projects and Programs?

A project is a Motion Builder directory used to organize related programs
with common set-up parameters.  When programming with Motion Builder,
you must be working within a project.  Stand-alone programs are not
allowed.

A program is a series of commands that are executed in the order in which
they are programmed.  With Motion Builder, these commands are represented
by icons.

A project contains three types of files:

*.PRJ file ASCII text file that describes:

· The 6000 series product being used
· The configuration information for set-up
· List of programs in the project
· Main Program
· Setup program
· Error Program
· Indication of whether the Build is debug or non-debug

The *.PRJ file has the same root name as the project.

*.BUD files Contain the symbolic representations of the programs
created with icons, plus information from the icon dialog
boxes.

*.PRG files Contain the actual 6000 series commands generated by
using the Build command for a project.  Each *.BUD
program file that is included in a project build will have a
corresponding *.PRG file with the same root name.
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Creating a Project

Creating a New Project
1. Choose New from the Project menu.
2. Type in the Project Name (no more than 6 characters).
3. In the 6000 Product pane, select the 6000 series product to be used.
4. Select the drive on which to store the project.
5. In the Subdirectory pane, enter or select the name of the desired

subdirectory..
6. Chose the OK button to the close the New Project dialog box.
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Creating a New Program
1. Choose New from the Program menu.
2. Type in Program Name (no more than 6 characters).

Program names canÕt begin with a number nor can they be the same as
6000 commands.

3. In the 6000 Product pane, select the 6000 series product to be used.
4. Select the drive on which to store the project.
5. In the Subdirectory pane, enter or select the name of the desired

subdirectory..
6. Chose the OK button to the close the New Program dialog box.

Configuring System Operating Parameters
Before developing programs, you should verify that all your application's
relevant "setup" categories, found under the Setup menu, are configured for
your application.

The parameters from all setup categories are automatically saved into a
"setup" program when you build your project.  A check-mark appears next to
the Setup menu item to let you know you've customized the setup
parameters.

When you run your "main" motion program, the setup program will be
automatically executed first to prepare the 6000 controller fro subsequent
motion control functions.  The information in the setup program is based on
the state of the system configuration information at the time of the project
build.  Every project requires a setup program.

Refer to the Configuring Your System section of this manual for
descriptions of the Setup categories and their associated dialog boxes.
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Set Build Options for a Project
Before building a project, you should designate the main program and error
program for the build.  (See below.)

1. Select the Build Options command from the Project menu.
2. Select if the Build Mode is to be Debug or Non-Debug.
3. If you wish to change the main program, select the new main program

from the drop-down box.  The first program created in the project is the
default main program.

4. (Option)  Select the error program for the project with the drop-down
box.

5. Select if the main program is to be the start-up program (stand-alone
controllers only).

Main Program
The Main Program in a project contains the predominant logic flow of
motion and I/O for the application.

Error Program
The purpose of the error program is to provide a programmed response to
certain error conditions that may occur during the operation of your system.
Programmed responses typically include actions such as shutting down the
drive(s), activating or de-activating outputs, etc.  If an error condition occurs
and the associated error-checking bit has been enabled with the Error
Checking Icon, the 6000 controller will branch to the error program.  See the
On-line Help system for more detailed information about error programs, as
well as about error conditions and their remedies.

Building a Project
1. Use the Edit command from the Project menu to select which programs

in the Project directory are to be considered part of the build.  All
programs created while in the project are automatically stored in the
Project directory, and will be included in the build unless de-selected..

2. Use the Build Options command from the Project menu to specify the
main program and the error program for the project build.  Also select
if the main program is to be the Start-up Program (stand-alone
controllers only).

3. If you wish to only build the programs (those previously selected for
the build) that have changed since the last build for the project, select
the Build command from the Project menu.  The purpose of this is to
save Build compilation time for large projects.

4. If you wish to rebuild all the programs (those previously selected for
the build) regardless of when they last changed, select the Rebuild All
command from the Project menu.
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Downloading a Project to the Controller
Before you can execute the programs of your project, you must download
them to the controller's memory.

1. Select the Communications Setup command from the Run menu.
2. For stand-alone products, select the Communications Port with the

drop-down box.  For bus-based products, select the device address from
the drop down box.

3. Select the Connect command from the Run menu to establish the
communication link with the 6000 Series controller.

4. Select the Download Project command from the Run menu.  A window
should appear with the contents of your programs scrolling by,
followed by a message stating that the download is complete.  Your
programs now reside in the controller's memory.

Running the Main Program of a Project
To run the main program of your project (as well as the subprograms), select
the Run Main Program from the Run menu.

Saving a Project
A project is saved by saving the elements of the project Ð the programs.

1. Choose Save from the Program menu.
2. Repeat Step 1 for each Program in the project that is open before

closing the Project.

Try the Tutorial

The tutorial section of this manual demonstrates the basic process, as just
described, for developing a project using Motion Builder
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Configuring System Operating Parameters

Before you begin to program your 6000 Product, you should establish basic
operating (ÒsetupÓ) parameters for your project.  These setup parameters are
compiled into a setup program which configures the 6000 Series controller at
the start of the project.

Failure to configure setup parameters can lead to unexpected results.
Operating systems for 6000 Series controllers contain default values for these
parameters that may not be what you expect.  (Refer to the Installation Guide
for your 6000 Product.)

Participating Axes

If you are not going to use all the axes of your 6000 Series product, use this
setup parameter to remove from service the unnecessary axes.  This reduces
the size of motion programs by excluding parameters for non-participating
axes.  For servo products, it improves performance by allowing faster servo,
motion trajectory, and system update rates.

The default condition is that all axes on the product are included in
programming.

To reduce the number of participating axes
1. From the Setup menu, select Participating Axes.
2. Select the maximum number of axes required for your application.

Note that the axis with the highest number is excluded; axis numbers
cannot be rearranged.  For example, if you have a 4-axis controller and
will use only 3 axes, select "Axes 1,2,3" and the controller will
function as if axis #4 was deleted from its design.



Configuring Your System 1 5

Drives

Unless you are using a packaged controller/drive (e.g., APEX6154, 6201,
ZETA6104, etc.), you need to configure the controller to work with the
connected drive.  If you are using a Compumotor or Digiplan drive, simply
select it from the drive selection box and all the configuration parameters
will be filled in for you.

To configure the drive(s)
1. From the Setup menu, choose Drives.
2. Select the affected axis.
3. Select the type of drive using the drop-down box.
4. Select if the Drive fault level is to be Active High or Active Low.
5. Enter the value for the Drive resolution (stepper products only)
6. Select the value for the Drive pulse width (stepper products only) with

the drop-down box.
7. Select if Disable drive on Killis to be enabled (servo products only).
8. Repeat steps 2-7 for each axis.
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Feedback Devices

Feedback device options depend on the product.  Use the appropriate
procedure below for your stepper or servo product.

To configure feedback for STEPPER PRODUCTS
1. From the Setup menu, choose Feedback.
2. Select the affected axis.
3. Set the encoder resolution.
4. Do one or both of the following (as your application requires):

¥ Enable and set up Position Maintenance
¥ Enable and set up Stall Detection

5. Repeat steps 2-4 for each axis.
6. Choose the OK button.

NOTE -- Steppers

If you enable position maintenance or stall detection, all the motion on
the respective axis in the current program/project will be based on
encoder-based positioning.
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Feedback Devices  (cont'd.)

To configure feedback for SERVO PRODUCTS
1. From the Setup menu, choose Feedback.
2. Select the affected axis.

3. Select the feedback source from the Feedback Selection area.
4. Fill in the Feedback Setup information for the feedback source:

Encoder

ANI (Analog Input)

LDT(Linear Displacement Transducer for 6270 only)

Resolver (internal resolver for APEX615n Series products only)

5. Repeat steps 2-4 for each axis.
6. Choose the OK button.

NOTE -- Servos

If you change the feedback source in your motion program, the scaling
and tuning parameters will automatically change to match the feedback
source.  Gain values may also change.



1 8 Motion Builder Start-Up Guide

Axis Scaling

Scaling allows you to program acceleration, deceleration, velocity, and
position values in units of measure that are appropriate for your application.
Axis scaling pertains to general, point-to-point motion.  See example
scaling scenarios.  The scaling parameters for servo systems are specific to
the feedback source; therefore, if your application requires you to switch
between feedback sources, make sure you have set up the desired scaling for
each feedback source.

NOTE:  To ensure that all programmed motion values are scaled for your
application, be sure to include Scaling in your Setup program, and select the
Main program as the Start-up program.

To Define Axis Scaling Parameters
1. From the Setup menu, select Axis Scaling.
2. Select the affected axis.
3. SERVO PRODUCTS:  Select the feedback source.
4. Fill in the desired scaling value for accel/decel, including the desired

units of measure for your application.
5. Fill in the desired scaling value for distance, including the desired units

of measure for your application.
6. Fill in the desired scaling value for velocity, including the desired units

of measure for your application.
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Path Scaling

Scaling allows you to program acceleration, deceleration, velocity, and
position values in units of measure that are appropriate for your application.
Path Scaling pertains to linear interpolated motion.  See example scaling
scenarios.  The scaling parameters for servo systems are specific to the
feedback source; therefore, if your application requires you to switch between
feedback sources, make sure you have set up the desired scaling for each
feedback source.

NOTE:  To ensure that all programmed motion values are scaled for your
application, be sure to include Scaling in your Setup program, and select the
Main program as the Start-up program.

To Define Scaling Parameters
1. From the Setup menu, select Path Scaling.
2. Fill in the desired scaling value for accel/decel, including the desired

units of measure for your application.
3. Fill in the desired scaling value for velocity, including the desired units

of measure for your application.

NOTE: If you are using Path Scaling, you must configure identical
Distance Scaling using Axis Scaling.
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Programmable Inputs

Programmable inputs are provided to allow the controller to detect the state
of switches, thumbwheels, electronic sensors, and outputs of other
equipment, such as drives and PLCs.  Based on the state of the inputs, and
programmable outputs, the controller can make program flow decisions and
assign values to binary variable for subsequent mathematical operations.

Configuration of programmable inputs, including trigger inputs, consists of
assigning an Input Function for each input to be used and defining if it is to
be considered active high or active low.

To configure programmable inputs
1. From the Setup menu, choose Programmable Inputs
2. Select the affected programmable input to be configured.

3. Within the Input Level area, select if the input is to be Active High or
Active Low.

4. Select the desired Input Function for the selected programmable input.
Programmable Input
Kill
Stop
Pause/Continue
User Fault
Capture Position (Triggers Only)
Jog POS (CW), w/ Axis #
Jog NEG (CCW), w/ Axis #

5. Repeat steps 2-4 for each axis.
6. Select if the Setup for Programmable Inputs is to be included in the

Setup Program.
7. (Optional) Complete Jog Setup
8. (Optional) Complete Program Setup.
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Programmable Inputs:  Jog Setup

Use to set the necessary Jog motion parameters, in conjunction with the
assignment of programmable inputs for Jog POS (CW), Jog NEG (CCW),
and Jog Speed Select.

To configure Jog parameters
1. From the Setup menu, choose Programmable Inputs
2. Select the affected programmable input to be configured as Jog POS

(CW).

3. Within the Input Level area, select if the input is to be Active High or
Active Low.

4. Repeat Steps 2 and 3 for Jog NEG (CCW) and Jog Speed Select.

5. Place the cursor over the Jog Button in the Setup area of the dialog
box, and click the left mouse button to display the Setup Jog dialog
box.

6. Select the affected axis.
7. Fill in the Jog acceleration value for the affected axis.  Make sure that

the value is within the allowed acceleration range.
8. Fill in the Jog deceleration value for the affected axis.  Make sure that

the value is within the allowed deceleration range.
9. Fill in the Jog Velocity High value for the affected axis.  Make sure

that the value is within the allowed velocity range.
10. Fill in the Jog Velocity Low value for the affected axis.  Make sure

that the value is within the allowed velocity range.
11. Repeat Steps 6-10 for any other affected axes.
12. Select if Jog Setup parameter are to be included in the Setup Program.
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Programmable Outputs

Programmable outputs are provided to allow the controller to respond to the
state of switches, thumbwheels, electronic sensors, and outputs of other
equipment, in conjunction with programmable inputs.

Configuration of programmable inputs, including trigger inputs, consists of
assigning an Input Function for each input to be used and defining if it is to
be considered active high or active low.

To configure programmable outputs
1. From the Setup menu, choose Programmable Outputs
2. Select the affected programmable output to be configured.
3. Within the Output Level area, select if the output is to be Active High

or Active Low
4. Select the desired function for the selected programmable output.

Programmable Output
Moving
Fault
Program in Progress
Stall
At Limits
Position Error (Servos only)
Output on Position (Servos only)

5. Repeat steps 2-4 for each axis.
6. Select if the Setup for Programmable Outputs is to be included in the

Setup Program.
7. (Optional) If Output on Position is assigned to any of the auxiliary

outputs (Special Output A through Special Output D), fill in
position parameters using the Setup Output on Position dialog box.
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Configuring Limit Functions

The purpose of hardware and software end-of-travel limits is to prevent the
motorÕs load from traveling past defined limits.  Software and hardware
limits are typically positioned in such a way that when the software limit is
reached the motor/load will start to decelerate toward the hardware limit, thus
allowing for a much smoother stop at the hardware limit.  Software limits
can be used regardless of incremental or absolute positioning.
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Hardware End-of-Travel Limit Inputs

6000 Series controllers are shipped from the factory with the hardware end-of-
travel limit inputs enabled, but not connected.  Therefore, motion will not be
allowed until you do one of the following:

· Install limit switches or jumper the end-of-travel limit terminal
to the GND terminal (refer to your productÕs Installation Guide
for wiring instructions).

· Disable the limits with the Setup Hard Limits dialog box.
· Reverse the active level of the limits with the Setup Hard

Limits dialog box.

To configure hardware limits
1. From the Setup menu, choose Limit Inputs
2. Place the cursor over the Hard Limit Button in the dialog box, and click

the left mouse button to display the Setup Hard Limits dialog box.
3. Select the affected axis.
4. Enter the Hard Limit Deceleration value.   Make sure that the value is

within the allowed deceleration range.
5. Select if the NEG (CCW) Hard Limit is to be Enabled or Disabled.  If

disabled, motion will not be restricted when NEG (CCW) Hard Limit is
reached.

6. Select if the POS (CW) Hard Limit is to be Enabled or Disabled.  If
disabled, motion will not be restricted when POS (CW) Hard Limit is
reached.

7. Select if the NEG (CCW) Hard Limit Input is to be Active High or
Active Low.

8. Select if the POS (CW) Hard Limit Input is to be Active High or
Active Low.

9. Repeat steps 3-8 for each axis.
10. Select if the Setup for Hard Limits is to be included in the Setup

Program.
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Software End-of-Travel Limits

The software limits are referenced from a position of absolute zero.  Both
software limits may be defined with positive values or negative values, as
long as the POS (CW) limit is greater than the NEG (CCW) limit.

Care must be taken when performing incremental moves because the
software limits are always defined in absolute terms.  Software limits must
be large enough to accommodate the moves, or a new zero reference position
must be defined using the Set Absolute Position Icon.

To configure software limits
1. From the Setup menu, choose Limit Inputs
2. Place the cursor over the Soft Limit Button in the dialog box, and click

the left mouse button to display the Setup Soft Limits dialog box.
3. Select the affected axis.
4. Enter the Soft Limit Deceleration value.   Make sure that the value is

within the allowed deceleration range.
5. Select if the NEG (CCW) Soft Limit is to be Enabled or Disabled.  If

disabled, motion will not be restricted when NEG (CCW) Soft Limit is
reached.

6. Select if the POS (CW) Soft Limit is to be Enabled or Disabled.  If
disabled, motion will not be restricted when POS (CW) Soft Limit is
reached.

7. Enter the NEG (CCW) Range value in absolute steps.  If scaling is
enable, this is internally multiplied by the distance scaling factor.

8. Enter the POS (CW) Range value in absolute steps.  If scaling is
enable, this is internally multiplied by the distance scaling factor.

9. Repeat steps 3-8 for each axis.
10. Select if the Setup for Soft Limits is to be included in the Setup

Program.
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Home Limits

A homing operation is a sequence of moves that position an axis using the
Home Limit input and/or the Z-Channel input of an incremental encoder.
The goal of the homing operation is to return the load to a repeatable initial
starting location.   See Homing Examples

To configure home limits
1. From the Setup menu, choose Limit Inputs.
2. Place the cursor over the Home Limit Button in the dialog box, and

click the left mouse button to display Setup Home Limits dialog box.
3. Select the affected axis.
4. Within the Home Operation area, select Backup to home or No Backup

to home.
5. Within the Home Reference Edge area, select whether to stop on the

POS (CW) or the NEG (CW) side of the home switch.
6. Within the Home Active Level area, select if the Home Limit input is

to be Active High or Active Low.
7. (Optional) Within the Home Backup area, enter the velocity for the

final approach to home position during backup to home or during
homing to the Z-channel.  Make sure that the value is within the
allowed velocity range.

8. (Optional) Within the Home Backup area, specify POS (CW) or NEG
(CCW) for the final approach direction to home position during backup
to home or during homing to the Z-channel.

9. (Optional) Enable Z-channel homing.
10. Enter the Home Velocity value.  Make sure that the value is within the

allowed velocity range.
11. Enter the Home Acceleration value.   Make sure that the value is within

the allowed acceleration range.
12. Enter the Home Deceleration value.   Make sure that the value is within

the allowed deceleration range.
13. Repeat steps 3-12 for each axis.
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Configuring Joystick Inputs
Use to configure such that the analog inputs can be used to produce motion
on a specific axis.  Motion will be directly proportional to the voltage on the
analog inputs, which is linearly related to the joystick positioning.

Joystick Motion

To configure joystick motion parameters
1. From the Setup menu, choose Joystick.
2. Place the cursor over the Joystick Motion Button in the Setup

Joysticks dialog box, and click the left mouse button to display the
Setup Joystick Motion dialog box.

3. Select the affected axis.
4. Enter the Acceleration value to be used during joystick mode.   Make

sure that the value is within the allowed acceleration range.
5. Enter the Deceleration value to be used during joystick mode.   Make

sure that the value is within the allowed deceleration range.
6. Enter the Velocity High value to be used during joystick mode.  Make

sure that the value is within the allowed velocity range.
7. Enter the Velocity Low value to be used during joystick mode.  Make

sure that the value is within the allowed velocity range.
8. In the Analog Channel area, select the Analog Channel High from the

drop-down box.
9. In the Analog Channel area, select the Analog Channel Low from the

drop-down box.
10. Repeat steps 3-9 for each axis to be controlled by joystick.
11. Select if the Setup for Joystick Motion is to be included in the Setup

Program.
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Joystick Electronics

To configure joystick electronics parameters
1. From the Setup menu, choose Joystick.
2. Place the cursor over the Joystick Electrons Button in the Setup

Joystick dialog box, and click the left mouse button to display the
Setup Joystick Electronics dialog box.

3. Select the affected analog channel from the drop-down box.
4. Enter the Center Position Voltage value.
5. Enter the Center Deadband Voltage value.
6. Enter the End Deadband Voltage value.
7. Repeat steps 3-6 for each analog channel to be used.
8. Select if the Setup for Joystick Electronics is to be included in the

Setup Program.
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Joystick:  Feedrate Override

(Steppers Only)  Feedrate Override is used to synchronously scale all
phases of motion on all axes (except distance)for joystick moves.  The
amount of scaling is expressed in terms of percentage from 0 t0 100.  The
percentage of feedrate can be controlled by an analog voltage (Hard) or by a
software command (Soft).

When feedrate override is enabled, the frequency at which the controllerÕs
motion algorithm updates the velocity output varies according to the feedrate
percentage.  Without feedrate override, the motion algorithm is updated every
2 milliseconds.  At 100%, the velocity output is updated every 2
milliseconds.  At 50%, the velocity output is updated every 4 milliseconds.

To configure feedrate override
1. From the Setup menu, choose Joystick.
2. Place the cursor over the Feedrate Override Button in the Setup

Joysticks dialog box, and click the left mouse button to display the
Setup Feedrate Override dialog box.

3. In the Feedrate Override Type area, select None, Hard, or Soft.  If None
is selected, Feedrate Override is disabled.

4. Enter the Feedrate Override Acceleration value to be used during joystick
mode.

5. If Soft Feedrate Override was selected in Step 3, enter the Feedrate
Override Percentage.  Continue to Step 7.

6. In the Hard Feedrate Override area, use the drop-down boxes to select
the Analog Channel High and the Analog Channel Low.

7. Select if the Setup for Feedrate Override is to be included in the Setup
Program.
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Servo Tuning

The 6000 Series servo controllers use a digital control algorithm to control
and maintain the position and velocity.  The digital control algorithm
consists of a set of numerical equations used to periodically (once every servo
sampling period) calculate the value of the control signal output.  The
numerical terms of the equations consist of the current commanded position
value and actual position value (plus a few from the past sampling period)
and a set of control parameters.  Each control parameter, commonly called a
gain, has a specific function.  Tuning is the process of selecting and
adjusting these gains to achieve optimal servo performance.

When this control algorithm is used, the whole servo system is a closed loop
system.  It is called closed loop because the control algorithm accounts for
both the command (position, velocity, tension, etc.) and the feedback data
(from the encoder); therefore, it forms a closed loop of information flow.

When all gain sets are set to zero, the digital control algorithm is essentially
disabled and the system becomes an open loop system.  During system setup
or troubleshooting it is desirable to run the system in open loop so that you
can independently test the drive and motor operation.
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Servo Tuning:  Assigning Specific Gain Values

To configure gain sets for servo tuning
1. From the Setup menu, choose Servo Tuning
2. Select the gain set to be defined or modified.  If gain values for the

feedback sources for each axis will remain the same throughout your
project, select None.

3. (Optional) To launch Servo Tuner to help determine the optimal gain
values for your project, place the cursor over the Launch Servo Tuner
Button in the Gain Set area, and click the left mouse button.

4. (Optional) To import gain sets that were calculated with Servo Tuner,
place the cursor over the Import Servo Tuner Gains Button in the Gain
Set area, and click the left mouse button.

5. Select the affected axis for the gain values being defined.
6. Select the desired Feedback Device.
7. Enter the Maximum Position Error value.
8. Enter the positive and negative Proportional Feedback Gain values.
9. Enter the positive and negative Integral Feedback Gain values.
10.  Enter the Integral Windup Limit value.
11.  Enter the positive and negative Velocity Feedback Gain values.
12.  Enter the positive and negative Acceleration Feedforward Gain values.
13.  Enter the positive and negative Velocity Feedforward Gain values.
14.  If your project requires switching between feedback sources for the same

axis, repeat Steps 6-13 for each feedback source for the selected axis
(only if Gain Set is None).

15.  Repeat steps 5-14 for each axis.
16.  Repeat steps 2-13 for each desired gain set.  If None was selected in Step

2, proceed to Step 17.
17.  Select if the Setup for Gain Sets is to be included in the Setup Program.
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Defining End-of-Move Settling Criteria

When using the target zone settling criteria, the motorÕs actual position and
actual velocity must be within the specified target zone and within the
specified velocity band before motion can be determined complete.  Use to
prevent premature command execution before the actual position settles into
the commanded position.

If the motor does not settle into the target zone before the specified time-out
period, the servo controller detects an error.  If this error occurs, you can
prevent subsequent command and/or move execution by using the Enable
Error Checking Icon to continually check for this error condition, and when
it occurs, to branch to a programmed response defined in the Error Program.

To configure settling criteria
1. From the Setup menu, choose Settling Criteria.
2. Select the affected axis.
3. Enable the Target Zone Settling mode.
4. Enter the Target Distance Zone value.
5. Enter the Target Velocity Zone value.
6. Enter the Target Settling Timeout Period value.
7. (6270 only)  Enter the Setpoint Window Distance.
8. (6270 only)  Select the Setpoint Window Gain Set from the drop-down

box.
9. Repeat steps 2-8 for each axis.
10. Select if the Setup for Settling Criteria is to be included in the Setup

Program.
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ZETA Damping

To configure ZETA damping
1. From the Setup menu, choose ZETA Damping
2. Select the affected axis.
3. In the Damping Method area, select if Active Damping is to be Enabled

or Disabled.
4. In the Damping Method area, select if Anti-Resonance is to be Enabled

or Disabled.
5. In the Damping Method area, select if Electronic Viscosity is to be

Enabled or Disabled.
6. In the Options area, select the Waveform with the drop-down box.
7. In the Options area, select if Auto Current Standby is to be Enabled or

Disabled.
8. In the Active Damping area, select the type of units with the drop-down

box.
9 In the Active Damping area, select the type of motor to be used
10. In the Active Damping area, select the Motor Inductance with the drop-

down box.
11. In the Active Damping area, select the Motor Static Torque with the

drop-down box.
12. In the Active Damping area, select the Total Inertia with the drop-down

box.
13. In the Active Damping area, select the Active Damping level with the

drop-down box.
14. In the Electronic Viscosity area, select the Viscosity Level with the

drop-down box.
15. Repeat Steps 2-14 for other axes.  (ZETA6104 has only one axis.)
16. Select if the Setup for ZETA Damping is to be included in the Setup

Program.
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Variable & I/O Names

Use to name numeric variables, binary variables, programmable inputs, and
programmable outputs.

To configure variable & I/O names
1. From the Setup Menu, choose Variable & I/O names.
2. Select Numeric Variables, Binary Variables, Programmable Inputs, or

Programmable Outputs.
3. Select the desired variable, input or output to be named.
4. Type in the desired name in the Edit Name field.
5. Repeat steps 2-5, as desired.



 Motion Builder™

I C O N S
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Pointer Icon

Use to un-select a previously selected Icon, thus aborting placement of that
icon onto the program sheet.  An arrow cursor indicates that Motion Builder
is in Pointer Icon mode.

Motion Builder must be in Pointer Icon mode to delete a link.
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Link Icon

The Link Icon is used to engage the Linking function of Motion Builder.
When the Linking function is engaged,  a cross-hatch cursor is displayed.
Once selected, the Link function stays selected until you select another icon,
the Pointer, or by double-clicking your left mouse button.
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Move Profile Icon

Use to create a complete profile of a move segment with a single icon.

To create a move profile
1.  Open the Move Profile Icon dialog box.
2.  Select a move type of point-to-point or linear interpolation.
3.  Select the affected axis.
4.  Fill in the acceleration value for the axis or for path acceleration.
5.  Fill in the velocity value for the axis or for path velocity.
6.  Fill in the distance value.
7.  Fill in the deceleration value for each axis or for path deceleration.
8.  For a point-to-point move, repeat steps 3-7 until all affected axes of the

move profile have been addressed.  For a linear interpolated move,
repeat steps 3 and 6 until all affected axes of the move profile have been
addressed

9.  (Optional)  If desired, select  S-Curve Profile.
10.  (Optional)  If desired, select Wait for move complete.
11.  (Optional)  Use View Motion Profile to preview the profile being

created.
12.  Select the axes on which to initiate motion.
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Group Icon

Use to branch to a subprogram.  Select an existing program as the designated
subprogram in the drop-down box of the Group Dialog Box.  The
subprogram that the Group Icon initiates will return control to the icon after
the Group Icon when the subprogram completes operation.

Up to 16 levels of subprogram calls can be made without receiving an error.

To branch to a subprogram
1.  Open the Group Icon dialog box.
2.  Select the desired program from the drop-down box.

Note: The Group Icon is equivalent to the GOSUB command in the 6000
Series programming language.
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Wait Icon

Use to interrupt program flow;  the program will wait for a specified time
interval to elapse or a condition to become true before program flow
continues.  Once the specified time has elapsed or the indicated condition
becomes true, program flow will continue to the Icon following the Wait
Icon, and the associated commands will be executed.

To wait for a constant time
1.  Open the Wait Icon dialog box.
2.  Select Wait for Constant Time.
3.  Enter the desired time delay value.  Make sure the delay is within the

time delay range.

To wait for a variable time
1.  Open the Wait Icon dialog box.
2.  Select Wait for Variable Time.
3.  Select the desired variable for the delay value from the drop down box.

Make sure the variable value will not exceed the time delay range.



Icons 4 1

Wait Icon (cont'd)

To wait for a status condition
1.  Open the Wait Icon dialog box.
2.  Select Wait for Status.
3.  Select the desired status type from the drop down box.
4.  Place the cursor over the selected status type in the drop-down box and

double-click the left mouse button to display the status dialog box.
5.  To set the status condition, place the cursor over the desired status bit(s)

button.  Click the left mouse button to toggle between the Yes, No,
and Ignore states.  Select Yes to wait for that bit to be active.  Select
No to wait for that bit to be inactive.  The default state is Ignore.

To wait for a conditional expression
1.  Open the Wait Icon dialog box.
2.  Select Wait for Expression.
3.  Place the cursor over the Expression button and click the left mouse

button to display the Relational Expression dialog box.
4.  Define the conditional expression to wait for using the Relational

Expression dialog box.

See the Conditional IF Icon for example of Relational Expression and Status
dialog box.
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Conditional IF Icon

Use to create conditional branching within programs.  If the defined
expression evaluates true, then command processing continues with the first
Icon command linked to the True branch.  If the defined expression evaluates
false, then command processing continues with the first Icon command
linked to the False branch.

Up to 16 levels of Conditional IF statements can be nested without receiving
an error.  Use caution when nesting Conditional IF statements.

To create branching based on status condition
1.  Open the Conditional IF Icon dialog box.
2.  Select IF Status.
3.  Select the desired status type
4.  Place the cursor over the selected status type in the drop-down box and

double-click the left mouse button to display the status dialog box.
5.  To set the status condition, place the cursor over the desired status bit

button.  Click the left mouse button to toggle between the Yes, No,
and Ignore states.  Select Yes to wait for that bit to be active.  Select
No to wait for that bit to be inactive.   The default state is Ignore.

6.  Repeat step 5, if desired.  To display the next group of eight status bits,
place the cursor over the Next button and click the left mouse button.
To display the a previous group of eight status bits, place the cursor
over the Previous button and click the left mouse button.
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Conditional IF Icon  (cont'd)

To create branching based on relational expression
1.  Open the Conditional IF Icon dialog box.
2.  Select IF Expression.
3.  Place the cursor over the Expression Button and click the left mouse

button to display the Relational Expression dialog box.
4.  Define the conditional expression to branch with using the Relational

Expression.
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Set Breakpoint Icon

Use to set a place in the program where command processing will halt.  This
is primarily useful for stopping a program at specific locations in order to
test status for debugging purposes.

To use the Breakpoint Icon
1.  Place the Icon in the position in the program at which you wish to stop

program flow.
2.  Perform any debugging or other operations.
3.  Resume command processing with the Continue to Next Breakpoint

command or Single Step command from the Run Menu.
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User Defined Function Block Icon

Use to create a user defined function block with 6000 series programming
commands to handle motion programming tasks not addressed directly in
Motion Builder.

To create a user defined function block
1.  Open the User Defined Function Block Icon dialog box.
2.  Enter in the desired 6000 series programming commands and parameters

NOTE: Refer to the 6000 Series Software Reference Guide for
command, protocol, and syntax information.
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Error Checking Icon

Use to enable error checking capabilities for a variety of listed error
conditions.  To make use of this Icon, write an error program that responds
to these error conditions, and designate it as the error program for the project.
These error conditions may be used as parts of conditional expressions with
the Conditional IF Icon, Wait Icon, and Assignment Icon.

To enable error checking
1.  Open the Error Checking Icon dialog box.
2.  Select the error conditions to be enabled from those listed by positioning

the cursor in the associated box and clicking once with the left mouse
button .  A check mark indicates that a condition has been selected.

3.  To disable error checking for an error condition, position the cursor in the
associated box and click once with the left mouse button .  A blank
box indicates that a condition has been disabled.
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Set Acceleration Icon

Use to set the rates at which the motors for the desired axes will accelerate
when the next GO Iconcommand for that axis is received.  The acceleration
remains the same until you change it with a subsequent Set Acceleration
Icon command.

To set acceleration
1.  Open the Set Acceleration Icon dialog box.
2.  Select a move type of point-to-point or linear interpolation.
3.  Fill in the acceleration value for each axis or for path acceleration*.

Make sure that the value is within the allowed acceleration range.

*NOTE: If the motion parameter is to be assigned to a variable,
place the cursor over the data field and double-click the left mouse
button.  Use the resultant drop-down box to select the variable for
assignment.
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Set Velocity Icon

Use to define the speed at which the motor will run for a given axis when the
next GO Icon command for that axis is received.  The motor will accelerate
at a pre-defined acceleration rate before reaching the velocity specified.  The
velocity remains the same until you change it with a subsequent Set
Velocity Icon command.

To set velocity
1.  Open the Set Velocity Icon dialog box.
2.  Select a move type of point-to-point or linear interpolation.
3.  Fill in the velocity value for each axis or for path velocity*.  Make sure

that the value is within the allowed velocity range.

*NOTE: If the motion parameter is to be assigned to a variable,
place the cursor over the data field and double-click the left mouse
button.  Use the resultant drop-down box to select the variable for
assignment.
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Set Distance Icon

Use to define either the number of units the motor will move or the absolute
position it will seek after a GO Icon command.  In the incremental mode, the
distance value represents the total number of units you wish the motor to
move.  In the absolute mode, the distance value represents the absolute
position the motor will end up at;  the actual distance traveled will vary
depending on the absolute position of the motor before the move is initiated.
The distance remains the same until you change it with a subsequent Set
Distance Icon command.

To set distance
1.  Open the Set Distance Icon dialog box.
2.  Fill in the distance value for each axis*.  Make sure that the value is

within the allowed distance range.  Directionality for the move may be
assigned by filling in a positive value for a move in the positive
direction distance or a negative value for a move in the negative
direction.

*NOTE: If the motion parameter is to be assigned to a variable,
place the cursor over the data field and double-click the left mouse
button.  Use the resultant drop-down box to select the variable for
assignment.
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Set Deceleration Icon

Use to set the deceleration rates for the desired axes for the next GO Icon.
The acceleration remains the same until you change it with a subsequent Set
Deceleration Icon command.

To set acceleration
1.  Open the Set Deceleration Icon dialog box.
2.  Select a move type of point-to-point or linear interpolation.
3.  Fill in the deceleration value for each axis or for path deceleration*.

Make sure that the value is within the allowed deceleration range.

*NOTE: If the motion parameter is to be assigned to a variable,
place the cursor over the data field and double-click the left mouse
button.  Use the resultant drop-down box to select the variable for
assignment.
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GO (Initiate Motion) Icon

Use to start motion for the indicated axes using the motion parameters that
have been previously entered.

The motion parameters, such as acceleration, velocity, and distance, remain
set until you specifically change them.  If a motion parameter has not been
changed since the previous Go (Initiate Motion) Icon command (or Move
Icon command), the latest entries for the pertinent parameters will be used,
even if they are from a previous program.

To initiate motion within a program
1.  Open the GO (Initiate Motion) Icon dialog box.
2.  Select a move type of point-to-point or linear interpolation.
3.  Select the axes on which to initiate motion.
4.  (Optional)  If desired, select "Wait for move complete" for the selected

axes.
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Stop Motion Icon

Use to stop motion on the specified axes.  The Stop Icon command will
bring the specified axes to rest using the last deceleration values entered.

To stop motion within a program
1.  Open the Stop Motion Icon dialog box.
2.  Select a Stop or Kill-type deceleration.
3.  Select the axes on which to stop motion.
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Go Home Icon

Use to instruct the controller to search for the home position in the either the
positive or negative direction for the specified axes.  If an end-of-travel limit
is activated while searching for the home limit, the controller will reverse
direction and search for home in the opposite direction.  However, if a second
end-of-travel limit is encountered after the change of direction, the homing
operation will be aborted.

To initiate a homing move
1.  Open the Go Home Icon dialog box.
2.  For each axis, select a homing direction of either Positive (CW)or

Negative (CCW).  If no homing is desired for a given axis, select Do
Not Go Home.
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Set Absolute Position Icon

Use to offset the current absolute position to establish an absolute position
reference.  Also use to clear the offset.  The Set Absolute Position Icon
offset value (per axis) is specific only to the feedback source (per axis)
selected with the last Select Feedback Icon command.  If your application
requires switching between feedback sources for the same axis, then you
must select the feedback source with the Select Feedback Icon command and
issue an absolute position value specific to that feedback source. (Each
feedback source can have a separate offset.)

To establish an absolute position
1.  Open the Set Absolute Position Icon dialog box.
2.  Enter the absolute position values for the affected axes.  Use the same

range as for distance.
3.  (Optional) Select Clear Position Offset.
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Set Direction Icon

Use to set or change the direction of a move.  This Icon command is useful
for repeating a move in the opposite direction.

To establish an absolute position
1.  Open the Set Direction Icon dialog box.
2.  Select Positive (CW), Negative (CCW), Opposite Direction, or Do Not

Change for each affected axis.

Direction may also be specified with the Set Distance Icon by entering a
positive or negative distance value.  The final directional command issued
before a Go (Initiate Motion) Icon dictates the actual direction of motion.
When using the Set Direction Icon, place it after the Set Direction Icon in
the program flow to ensure that actual direction of motion is as desired.
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Motion Mode Icon

Use to specify whether the moves to follow are made with respect to current
position (incremental), with respect to an absolute distance, or with respect
to a specified velocity and direction (continuous).

To set the motion mode
1.  Open the Motion Mode Icon dialog box.
2.  Select the desired motion mode for each of the affected axes.
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Manual Mode Icon

Use to enable or disable joystick or jogging control of motion.  Jogging and
joystick parameters for a project are set using the Jog Setup command
(accessible from the Programmable Inputs command dialog box from the
Setup Menu) and the Joystick command from the Setup Menu..

To enable or disable manual control mode
1.  Open the Manual Mode Icon dialog box.
2.  Select the affected axis.
3.  Select either Enable, Disable, or No Change for Jog Mode.
4.  Select either Enable, Disable, or No Change for Joystick Mode.
5.  Repeat Steps 2-4 for all affected axes.
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Set Programmable Output State Icon

Use to set or change the state of the programmable output bits.

To set the programmable output states
1.  Open the Set Programmable Output State Icon dialog box.
2.  To set the status condition, place the cursor over the desired status bit

button.  Click the left mouse button to toggle between the On, Off,
and Same states.

3.  Repeat Step 2, if desired.  To display the next group of eight output bits,
place the cursor over the Next button and click the left mouse button.
To display the a previous group of eight output bits, place the cursor
over the Previous button and click the left mouse button.
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Assignment Icon

Use to assign variable or constant values to user-defined variables.  Variable
assignments can use constants, other variables, or conditional expressions.

To assign and compare variables
1.  Open the Assignment Icon dialog box.
2.  Select Numeric or Bitwise as the assignment type.
3.  Select the Assignment Format.
4.  Use the drop-down box on the left side of the assignment expression to

select the user-defined variable to be assigned.
5.  Place the cursor over the Operand 1 button and click the left mouse

button to display the Operand dialog box.
6.  Define the operand with the Operand dialog box.  If Numeric was selected

in Step 2, the Numeric Operand dialog box will be displayed.  If
Bitwise was selected in Step 2, the Bitwise Operand dialog box will be
displayed.

7.  If one of the two Òassign expressionÓ format types was chosen, place the
cursor over the Operand 2 button and click the left mouse button to
display the Operand dialog box.  If the Òassign operandÓ format type
was chosen, proceed to Step 9.

8.  Repeat Step 6.
9.  Select the type of relation between Operand 1 and Operand 2 using the

drop-down menu between them.
9.  Repeat Steps 4-9 for all affected user-defined variables.
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Enable Drive Icon

Use to enable or disable the drives for affected axes.

To enable or disable a drive
1.  Open the Enable Drive Icon dialog box.
2.  Select Enable, Disable, or DonÕt Change for each affected axis.
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Select Feedback Device Icon

Use to select or change the designated feedback sources for servo systems.
Choose from Encoder, Resolver, ANI, and LDT .  Configure feedback source
parameters with the Feedback command (Setup Menu).

To select a feedback device
1.  Open the Select Feedback Device Icon dialog box.
2.  Select the desired feedback source for each affected axis.
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Select Gain Set

Use to select from pre-defined gain sets for servo systems.  Gain sets are
defined for Motion Builder with the Servo Tuning command (Setup Menu).

To select a gain set
1.  Open the Select Gain Set Icon dialog box.
2.  Select the desired gain set using the drop-down boxes for each affected

axis.
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RP240 Icon

Use to display a message or numeric variable on the RP240Õs LCD.  Use to
store numeric data entered in from the RP240Õs keypad or function keys into
a variable.  Also use to control the state of the 8 programmable LEDs on the
RP240.

To display a message and/or numeric variable on an RP240
1.  Open the RP240 Icon dialog box.
2.  Position the cursor in the display field and click the left mouse button.
3.  Type in the desired message.  Be sure to follow RP240 message syntax.
4.   Define the format for desired display of Variables 95-98.

To read and store numeric data entered in from RP240 keypad
or function keys
1.  Open the RP240 Icon dialog box.
2.  Select "Read RP240 numeric keypad" if numeric data is to be entered in

from the RP240 numeric keypad.  See RP240 Sample Application A.
3.  Select "Read RP240 function key" if data will be entered in from the

RP240 function keys.  The function keys store a corresponding number
in Variable 100.  See RP240 Sample Application B.

4.  Select if program flow is to be paused to wait for input from RP240.

To control the state of LEDs on RP240
1.  Open the RP240 Icon dialog box.
2.  Place the cursor over the desired LED button.  Click the left mouse

button to toggle between the ON, OFF, and SAME states.
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Write to Port Icon

Use to transmit message strings to the designated port (Run Menu,
Communications Setup), either PC-AT bus or out the RS-232C port.  These
messages can then be used by the operating program.

To write a message to a port
1.  Open the Write to Port Icon dialog box.
2.  Enter the desired message.  Make sure to follow the message syntax.
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Begin Program Icon

Use to control program flow in the following ways:

Loop: Repeat the program a specified number of times.

Repeat: Repeat the program until a specified status or condition becomes
true.  Status or condition is evaluated at the end of the program.

While Run the program while a specified status or condition is true.
Status or condition is evaluated at the beginning of the program.

The End Program Icon defines the end of the Loop, Repeat Until, and While
Statements.

End Program Icon

Use to define the end of a program.  This is also used to define the end of
Loop, Repeat Until, and While Statements.



 



Tutorial
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Tutorial Introduction

Welcome to the Motion Builder Tutorial.  This tutorial, based on a
hypothetical application, is intended to demonstrate the basic process for
developing a program using Motion Builder:

1. Create a project and open the first program file for the project.

2. Establish basic operating (ÒsetupÓ) parameters for your application to

3. Develop several programs for the project.  (Drop the required icons
from the palette onto the worksheet, open and fill in the dialog boxes
for each icon, and link the icons according to the desired program flow.)

4. Build the programs.

5. Download the programs to the 6000 controller.

6. Run the programs.

About the Application

This tutorial is based on a two-axis, cut-to-length application designed to cut
two different widths of web stock.  Axis 1 controls the web feed and Axis 2
controls the saw carriage to cut the stock.  This application uses a 6200
controller, two OEM650 drives, and no encoder feedback (open loop is
acceptable).

The application will detail programming features such as:  creating
programs, configuration/setup, homing, defining variables, basic motion,
branching, programmable outputs, conditional statements, looping, building
programs, downloading, saving and testing programs.

          WARNING          

The primary purpose of this tutorial is to show you the basics of
programming a 6000 controller with the Motion Builder interface.
Furthermore, this tutorial is based on a hypothetical application using the
6200 stepper controller.  Consequently, the resulting programs may not be
suitable for your machine setup.

Although the tasks of downloading and running the program files
(producing actual motion) are included in this tutorial, they are not crucial
to understanding the programming process.

Therefore, If you intend to download and run the programs
generated from this tutorial, use extreme caution.  Make
sure the motors are NOT COUPLED to the load.

If you are using a servo system, you should do your tuning first (Servo
Tuner is bundled with Motion Builder Ñ to launch Servo Tuner, select Servo
Tuning from the Setup menu and click on the ÒLaunch Servo TunerÓ button.
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Objectives of the Cut-to-Length Application

This cut-to-length application will consist of two programs (called ÒFIRSTÓ
and ÒSECONDÓ) which will accomplish the objectives listed below.

Objectives/process of the ÒFIRSTÓ program (see NOTE below):

1. Home both axes.
2. Initialize the batch count variable.
3. Initialize a counter variable to zero.
4. Branch to the second program.

N O T E
In this application, the FIRST program is designated as a ÒstartupÓ
program, which is automatically executed when the 6200 is powered
up or reset (this feature is applicable only to stand-alone products).
The FIRST program is also designated as the ÒmainÓ program, which is
the overall controlling program for the application.  The first action of
the main program is to execute the ÒsetupÓ program.  The setup
program is automatically generated when you build a project; it
contains the setup parameters you fill out under the Setup menu in
Motion Builder.

Objectives/process of the ÒSECONDÓ program:

1. Start a repeat loop (repeat this program until the counter variable equals
the batch count variable).

2. Set the positioning mode of each axis.
3. Define and execute a move on axis 1 (increment the web stock).
4. Activate an output to turn on the saw blade.
5. Make axis 2 execute one of two cuts, based on the status of input #1:

- If input #1 is on, move axis 2 to cut a small piece of stock
- If input #1 is off, move axis 2 to cut a large piece of stock

6. Move axis 2 back to its starting position to prepare for the next cut.
7. Deactivate the saw blade output.
8. Increment the counter variable by 1.
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Tutorial

Step 1 Create a Project and Open a Program

1. To start your first programming exercise in Motion Builder, select New
from the Project menu.  Call the project "tutor.Ó  Select the 6200 from
the 6000 Product pull-down list.

When the project name is defined, Motion Builder creates a new
subdirectory under c:\mobud.  For example, your project files will be
stored in c:\mobud\tutor.

2. Click OK.

3. After you create a new project, a dialog box will appear asking you to
declare a program name.  Name the program Òfirst.budÓ.  Program names
are limited to six characters and they are created in the specified project
directory with a .bud extension.  For example, the ÒFIRSTÓ program is
created as c:\mobud\tutor\first.bud.
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4. Click OK.  Motion Builder opens a Òprogram worksheetÓ for FIRST.

End Program Icon

Begin Program Icon

Icon Palette

Program Worksheet Name of Project

Name of 6000 Product

Icon Label

CUSTOMIZING THE ICON LABELS:  Notice that when you
place an icon onto the program worksheet it has no label under it.  For
example, in the diagram above, the End Program icon has no label.  To
add or change a label to make the icon more meaningful (e.g., we added the
ÒStart ProgramÓ label to the Begin Program icon in the diagram above),
double-click the icon, select the Comments button (Ê  ), and type
in the desired label description in the Symbol Label field (see diagram
below).

    

The rest of this tutorial shows the icons with labels customized in this
manner.
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Step 2 Set Up Basic Operating Parameters

Before developing programs, you should verify that
all your application's relevant ÒsetupÓ categories,
found under the Setup pull-down menu, are
configured for your application.  (However, for this
tutorial, we will only change the Drives, Axis
Scaling, and Limit Inputs categoriesÑthe default
setup values for all other categories are acceptable.)

The parameters from all setup categories are
automatically saved into a ÒsetupÓ program when you
build your project.  A check-mark (3) appears next to
the Setup menu item to let you know you've
customized the setup parameters.

When you run your ÒmainÓ motion program (later in this tutorial), the setup
program will be automatically executed first, to prepare the 6000 controller
for subsequent motion control functions.

1. From the Setup menu, select Drives.  From the Stepper Drive pull-
down list, select OEM.  Notice that the Fault Level, Resolution, and
Pulse Width are automatically configured for the selected drive.

2. Select Axis #2 and select OEM.

3. Click OK.

4. From the Setup menu, select Axis Scaling.  Under Scale Factors,
set the Distance scaling to Ò12500Ó steps per Òinch.Ó  All subsequent
dialogs will represent the distance values in inches.
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5. Select Axis #2 and set the Distance scaling to Ò12500Ó steps per Òinch.Ó

6. Click OK.

7. From the Setup menu, select Limit Inputs.  Select the Hard
Limit button to invoke the Hard Limits dialog box.  Because this
tutorial is designed for a bench-test environment (DO NOT ATTACH
THE MOTORS TO THE LOAD), you will disable the hard limits.

8. Select Disable for both the NEG Hard Limit and the POS Hard Limit
inputs. (see diagram above)

9. Select Axis #2 and select Disable for both limits again.

10. Click OK in the Setup Hard Limits dialog box, and then click OK in
the Setup Limits dialog box.

SETUP IS COMPLETE

Save Your Programs Often
You should save your Motion Builder code frequently.  To do this,
click in the program worksheet area to make it the Òactive windowÓ
and choose Save or Save As under the Program menu (or click
the Save button in the toolbar Ñ  ).  Repeat this for each
program you have open.  (All programs in the project are saved
automatically when you Build your project — see Step 16 on page 27.)
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Step 3 Set Up Homing

Homing is an important functionality in many applications.  It allows you
to accurately position the axes of a machine for start up, and to establish zero
reference positions.

1. Drag the Begin Program and End Program icons apart to create room for
placing additional icons between them (see diagram below).

2. Select the Home icon from the palette (click on it).  Move the mouse to
the worksheet area and notice that the cursor becomes a small square.
Place the Home icon (click the mouse button) on the worksheet to the
right of the Begin Program icon.

ALIGNING THE ICONS:  An easy way to align the icons is to select
the icons to be aligned (while holding shift key click each icon, or click and
drag the mouse around the icons) and choose the appropriate alignment tool
from the toolbar to align them.  (diagram below uses the Align Top tool)

Select icons by
clicking & dragging
the mouseBlack squares

indicate icon
selected

Click the
Align Top tool

Icons are aligned
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3. Double-click on the Home icon to open the Go Home dialog box.  Set
axes 1 and 2 to begin homing in the positive-count direction.

4. Click OK.

Step 4 Assign Variables

In this application, numeric variable #1 is used as a batch counter and
numeric variable #2 is used as a loop counter (each cut represents one loop).

1. Select the Assignment icon and place it in the workspace next to the Go
Home icon.

2. Double-click the Assign icon to open the Assignment dialog box.
Select ÒAssign operand to a variable (a=b).Ó  Select ÒVariable 1Ó from
the Assignment pull-down list.
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3. Click on the Operand button (  ) to open the Numeric Operand
dialog box.  Select ÒDecimal ConstantÓ and type in Ò10Ó in the field.
This is the batch counter number.

4. Click OK in both dialog boxes.

5. Duplicate the Batch Count icon on the worksheet.  This will be used to
create the Loop Count icon.  To do this, follow this procedure:

a. Select the Batch Count icon with the mouse.

b. Copy the Batch Count icon to the clipboard.  To do this, use the
Ctrl/C keystroke or click the copy tool ( ) on the toolbar.

c. Paste the icon from the clipboard to the worksheet.  To do this, use
the Ctrl/V keystroke or click the paste tool ( ) on the toolbar.

6. Drag the new Assign icon over next to the Batch Count icon.  (see Loop
Count icon in diagram below)

7. Double-click the new Assign icon to open the Assignment dialog box.
Select ÒAssign operand to a variable (a=b).Ó  Select ÒVariable 2Ó from
the Assignment pull-down list.
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8. Click on the Operand button (  ) to open the Numeric Operand
dialog box.  Select ÒDecimal ConstantÓ and type in Ò0Ó in the field.
This initializes the loop counter to zero.

9. Click OK in both dialog boxes.

Step 5 Set Up Second Program

The motion portion of the application will be controlled by the SECOND
program, functioning as a subprogram to the FIRST program.

1. Select New from the Program menu to open the New Program dialog
box (see diagram below).  Call the new program Òsecond.budÓ.  This
adds the new second.bud program to the TUTOR project directory
(c:\mobud\tutor\second.bud).  The remainder of this tutorial refers to the
second.bud program as the ÒSECONDÓ program.
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2. Click OK.  Notice that the SECOND program worksheet is created in a
new window and that the SECOND and FIRST worksheet windows are
tile horizontally on your screen (the SECOND worksheet window is
above the FIRST worksheet window).

3. Drag the Begin Program and End Program icons apart to make room for
placing additional icons between them.  (in the diagram below, the
Begin Program icon is re-labeled ÒLoopÓ)

Step 6 Create a Conditional Loop Ñ Repeat/Until

1. This step is summarized in the following diagram:

1st
double-click

this icon
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a. Double-click the Begin Program icon to open the Begin Program
dialog box.  Select ÒRepeat Until ExpressionÓ and click on the
Expression button to open the Relational Expression dialog box.

b. Click on the Operand 1 button to open the dialog box.  Select ÒUser-
Defined VariableÓ and select Variable 2 from the pull-down list.
VariableÊ2 represents the loop counter.  Click OK.

c. Select ÒEqualÓ from the Relational Expression pull-down list.

d. Click on the Operand 2 button to open the dialog box.  Select ÒUser-
Defined VariableÓ and select Variable 1 from the pull-down list.
VariableÊ1 represents the batch count.  Click OK.

e. Click OK in the Relational Expression and Begin Program dialogs.

Step 7 Select Positioning Modes

1. Select the Cont/Abs/Inc Mode icon and place it next to the Begin
Program icon (in the diagram below, the Begin Program icon is re-
labeled ÒLoopÓ and the Cont/Abs/Inc Mode icon is re-labeled ÒInc/AbsÓ).

2. Double-click on the Cont/Abs/Inc icon to open the dialog box.  Select
Incremental positioning for axis 1 and Absolute positioning for axis 2.

3. Click OK.
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Step 8 Set Up Motion Ñ Axis 1 (Web Increment)

This step demonstrates setting up a move using the Move icon, which
consolidates Accel, Velocity, Distance, Decel, and Go functions.  You could
achieve the same programming using the respective individual icons (see
diagram below).  The individual icons are usually used to conditionally change
individual move elements based on other events or conditions in the
application.

Use This Or These

1. Select the Move icon and place it next to the Motion Mode icon.

2. Double-click on the Move icon to open the Move Profile dialog box.
Under Move Type, select Point-to-Point.  Under Execute Move, select
Axis 1.  Under Setup Move Profile, enter these values:  Distance = 14,
Accel = 50, Velocity = 4, Decel = 50.  Select the ÒWait for move
completeÓ box (this ensures the move is complete before program
execution continues).

If you wish to view the move profile, click the Recalculate button.  You
can view the Velocity, Position, or Accel/Decel profile.

3. Click OK.
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Step 9 Turn an Output ON

1. Select the Output icon and place it next to the Move icon (the diagram
below shows that the Output icon is re-labeled as ÒSaw On.Ó

2. Double-click the Outputs icon to open the Programmable Output dialog
box.  Click the button labeled ÒOutput 1 - SAMEÓ once to change to
button label to ÒOutput 1 - ON.Ó

3. Click OK.

Step 10 Create a Conditional Branch Ñ IF

Conditional branches allow the controller to make a decision based on certain
conditions, such as input status, motor position, etc.  In this application,
the controller must make a decision based on whether or not input #1 is on.
If input #1 is on, cut a short piece of stock; if input #1 is off, cut a long
piece of stock.

1. Select the IF Condition icon and place it next to the Output icon.
(re-labeled as ÒIF inputÓ in diagram below)
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2. Double-click the IF Condition icon to open the Conditional IF dialog
box.  From the IF Status pull-down list, select ÒInput Status.Ó
Double-click the field displaying ÒInput StatusÓ; this opens the Input
Status dialog box.  Click once on the button labeled ÒInput 1 - No
ChangeÓ to change it to ÒInput 1 - On.Ó

Double-Click

3. Click OK in both dialog boxes.

4. Select the Move icon and place it near the upper right corner of the IF
Condition icon.  (Move icon re-labeled as ÒShort CutÓ)

5. Double-click on the Move icon to open the Move Profile dialog box.
Under Move Type, select Point-to-Point.  Under Execute Move, select
Axis 2.  Under Setup Move Profile, select axis 2 from the pull-down
list and then enter these values:  Distance = 5, Accel = 50,
VelocityÊ=Ê0.5, Decel = 50.  Select ÒWait for move completeÓ to
ensure the move is complete before program execution continues.
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6. Click OK.

7. Select another Move icon and place it near the lower right corner of the
IF Condition icon.  (Move icon re-labeled as ÒLong CutÓ)

8. Double-click on the Move icon to open the Move Profile dialog box.
Under Move Type, select Point-to-Point.  Under Execute Move, select
Axis 2.  Under Setup Move Profile, select axis 2 from the pull-down list
and then enter these values:  Distance = 8, Accel = 50, VelocityÊ=Ê0.5,
Decel = 50.  Select ÒWait for move completeÓ to ensure the move is
complete before program execution continues.

9. Click OK.

10. Select another Move icon and place it near the lower right corner of the
Move icon labeled ÓShort Cut.Ó  (Move icon re-labeled as ÒReturnÓ)
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11. Double-click on the Move icon to open the Move Profile dialog box.
Under Move Type, select Point-to-Point.  Under Execute Move, select
Axis 2.  Under Setup Move Profile, select axis 2 from the pull-down
list and then enter these values:  Distance = 0, Accel = 50,
VelocityÊ=Ê2, Decel = 50.  Select ÒWait for move completeÓ to ensure
the move is complete before program execution continues.

12. Click OK.

Step 11 Turn an Output OFF

1. Select the Output icon and place it next to the Move icon labeled
ÒReturn.Ó (Output icon is re-labeled as ÒSaw OFF.Ó

2. Double-click the Outputs icon to open the Programmable Output dialog
box.  Click the button labeled ÒOutput 1 - SAMEÓ twice to change to
button label to ÒOutput 1 - OFF.Ó

3. Click OK.
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Step 12 Increment the Counter (Numeric Variable)

In this application, the SECOND program is repeated until the loop counter
(variable #2) value equals 10 (the value of variable 1).  The loop counter, for
this application, will be incremented after the stock is cut.

1. Select the Assignment icon and place it next to the Output icon labeled
ÒSaw OFF.Ó  (Assignment icon is labeled as ÒLoop + 1Ó)

2. This step is summarized in the following diagram:

1st
double-click

this icon

a. Double-click the Assignment icon to open the Assignment dialog
box.  Select ÒNumericÓ as the Assignment Type.  Select ÒAssign
expression to a variable (a=b+c).Ó  Select ÒVariable 2Ó from the
Assignment pull-down list.

b. Click on the Operand 1 button to open the dialog box.  Select ÒUser-
Defined VariableÓ and select Variable 2 from the pull-down list.
VariableÊ2 represents the loop counter.  Click OK.

c. Select ÒAddÓ from the pull-down list between the Operand 1 button
and the Operand 2 button.

d. Click on the Operand 2 button to open the dialog box.  Select
ÒDecimal ConstantÓ and type the number 1 in the field.  Click OK.

e. Click OK in the Assignment dialog.
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Step 13 Create a Branch to a Subprogram

The Group icon allows you to branch to other programs (subprograms) in
the project.  This is an important programming tool because it allows you to
create modular code.

1. In the FIRST program worksheet, select the Group icon (Ê Ê) and place
it between the ÒLoop CountÓ and the ÒEnd ProgramÓ icons.  (the Group
icon in the diagram below is re-labeled as ÒBranchÓ)

2. Double-click the Group icon to open the Group dialog box.  From the
Run Subprogram pull-down list, choose c:\motionb\tutor\second.bud.

3. Click OK.

Step 14 Link the Program Icons

Before a Motion Builder program can be built into 6000 code, the icons to be
included in the program must be linked together.  (It is possible to leave
some icons on the worksheet not connected so that you can test different
portions of code in separate builds.)

Use the following procedure as a guide to linking the icons.  After all the
icons are linked, the programs should look like the ones in the diagram
below.
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1. Select the Link tool (  ) from the icon palette.  After selecting the
Link tool, when you pass the cursor over the program worksheet area,
the cursor becomes a cross-hair (+).

2. Click the mouse on the right side (the output side) of the icon and then
click the mouse again on the left side (the input side) of the icon you
want to link.  After you click on an icon's output, when you move the
cursor, a dashed line trails behind.  When you link successfully to the
targeted icon, the line becomes solid with an arrowhead indicating the
direction of program flow.  The diagram below illustrates the
input/output connections.

1. Click

2. Drag

            

3. Click

NOTEÑThe If Condition icon has one output for True and one for False:
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Step 15 Set Build Options

1. From the Project menu, select Build Options (dialog box appears).

2. For the purposes of this tutorial, select Non-Debug as the Build Mode.

3. Under Customize Build Options, select Òc:\motionb\tutor\first.budÓ as
the Main Program.  The purpose of the Main Program as to function is
the main controlling program for the application.  Other programs in the
project (in this case, the second.bud program) are subprograms to the
Main program.

The first action that the Main program performs is to execute an
embedded Òsetup program.Ó  The setup program is automatically
generated when you build a project (setup.prg file appears in the tutor
directory); it contains the code for the setup categories found under the
Setup menu.

4. With Òc:\motionb\tutor\first.budÓ showing in the Main Program field,
click the Start-up Program box to assign the main program as the
Òstart-up program.Ó  The Start-up program, available only to stand-alone
controllers, is automatically executed every time the 6000 controller is
powered up or reset.

NOTE:  In this tutorial, an error program is not defined; therefore, you
should leave the Error program field blank.

5. Click OK.
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Step 16 Build Your Programs

CAUTION
Before building, select Edit from the Project menu and check that there
are no unwanted programs assigned to your project (see ÒFiles in ProjectÓ
list).  For this tutorial, the only files listed should be
Òc:\motionb\tutor\first.budÓ and Òc:\motionb\tutor\second.budÓ (see diagram
below)

The reason for this check is this:  If, while working in project A, you open a
program file from project B, project A automatically adds the program file
from project B to the ÒFiles in ProjectÓ list for project A.

1. Under the Project menu choose Rebuild All to build all programs in
the TUTOR project at one time.  The following Build window will
appear on your screen to show the progress of the build, and the files
resulting from the build.
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Step 17 Download Your Programs to the Controller

BEFORE YOU PROCEED
The purpose of this tutorial is to show you the basics of programming a
6000 controller with the Motion Builder interface.  The previous portions of
this tutorial have achieved this.  Although the tasks of downloading and
running the program files (producing actual motion) are included in the
remainder of this tutorial, they are not crucial to understanding the
programming process and may be attempted at your discretion.

1. Before you can execute your programs, you must download them to the
controllerÕs memory.  From the Run menu choose Communications
Setup and select the correct serial port (default is COM 2).  If you were
using a bus-based product (e.g., AT6400), instead of selecting a serial
port you would download the controllerÕs operating system.

2. From the Run menu, select Connect.  This establishes the
communication link with the 6000 controller.

3. From the Run menu, select Download Project.  A window like the
one displayed below should appear with the contents of your programs
scrolling by, followed by a message stating the download is complete.

(The ERRDEF, ERROK and ECHO commands in the last three lines are
simply communication setup commands generated by Motion Builder.)

Your programs now reside in the controller.
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Step 18 Run the Main Program

To run your main program (and subprograms), select Run Main Program
from the Run menu.

The program for this tutorial starts by commanding both motors to seek a
home switch.  To allow the rest of the program to continue, you must
ground the home limit switch (connect the HOM terminal to GND).  You
will notice the loops progress: each axis should move, in alternating
sequence with the other axis, a total of ten times and then stop.

If motion does not occur:

¥ Make sure the P-CUT or ENBL input is connected to ground (GND).

¥ If you are using a servo controller, make sure your feedback device is
connected properly and that your system is tuned.

¥ REFER ALSO TO THE TROUBLESHOOTING SECTION IN THE
ON-LINE HELP OR IN YOUR CONTROLLER'S MANUAL.

TUTORIAL COMPLETE
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